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Warning
Please pay attention to the following issues when purchasing or using the product:

There are small components included in this kit. Swallowing mistakenly or misoperation can
cause serious infection and be even fatal. When an accident occurs, please seek medical
assistance immediately.
Please place the product in a safe place where an under-3-year-old cannot touch, who should
not use or approach the product.
Juveniles should use the product with their parents.
Do not place the product or the components near any AC socket or other circuits, in case of
potential risks of electric shock.
Do not use the product near any liquid or flame.
Do not use or store the product in an extreme environment such as extremely cold or hot
and heavily humid.
Please remember to power off when the product is not in use.
Do not touch the moving or rotating part of the product.
The product may get heat at some part, which is just normal. But misoperation may cause
overheat.
Misoperation may cause damage to the product. Please take care.
Do not connect the positive and negative poles of the power inversely, or the devices in the
circuit may be damaged.
Please place and put the product gently. Do not smash or shock it.

About
Adeept is a technical service team of open source software and hardware. Dedicated to applying
the Internet and the latest industrial technology in open source area, we strive to provide best
hardware support and software service for general makers and electronic enthusiasts around the
world. We aim to create infinite possibilities with sharing. No matter what field you are in, we
can lead you into the electronic world and bring your ideas into reality.
The code and circuits of our product are open source. You can check on our website:

www.adeept.com

If you have any problems, feel free to send an email for technical support and assistance:
support@adeept.com

On weekdays, we usually will reply within 24 hours. Also welcome to post forums on our
website.

http://www.adeept.com
mailto:support@adeept.com
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Copyright
This user manual can be used for learning, DIY, refitting, etc., except for commercial purpose. The
Adeept Company owns all rights of contents in the manual, including but not limited to texts,
images, data, etc. Any distribution or printing should be implemented with the permission of the
Company, or it will be deemed illegal.
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Components List

Acrylic Plates

The acrylic plates are fragile, so please be careful when assembling them in case of breaking.
The acrylic plate is covered with a layer of protective film. You need to remove it first.
Some holes in the acrylic may have residues, so you need to clean them before the use.

A02
1pcs

A01
1pcs

A05
1pcsA04

1pcs
A03
1pcs

A08
6pcs

A06
1pcs

A07
3pcs
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Servo X1 DC Motor X2

Caster Wheel X1Driving Wheel X2

Machinery Parts

Electronic Parts

www.adeept.com www.adeept.com

X2

X2

M3*30
Screw

M2.5*10+6
Copper
Standoff
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X14

M2
Nut
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X14

M3
Nut
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X14

M2.5*7
Screw
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X2

M2*10
Screw
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X7

M2*8
Screw
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X20

M3*5
Screw
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X8

M3*8
Screw

M2.5*30
Copper
Standoff
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X8

M1.4*6
Self-tapping

Screw
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X4

M3*10
Countersunk

Head
Screw
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X4

M3*6
Copper
Standoff

M3*12
Copper
Standoff
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X2
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X4

M3*8
Copper
Standoff
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Adeept UNO R3 X1 Adeept Motor Shield V2.0 X1

HC-SR04 Ultrasonic Module X118650x2 Battery Holder X1

Adeept RGB LED Module X2 Adeept Passive Buzzer Module X1

Bluetooth Module X1Adeept Line Finder Module X2

4-Pin Wires X2

3-Pin Wires X3
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Tools

Self-prepared Parts

USB Cable X1

Jumper Wire M/M X4

Cross Screwdriver X1 Cross Socket Wrench X1Slotted Screwdriver X1

Winding Pipe X1

Ribbon X1

18650 Battery X2
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About the 3-Wheel-Driven Bluetooth Robot Car

Overview
The technology of artificial intelligence integrates the technologies of computer, physics,
physiology, control, and sensor and so on. Apart from traditional industrial sector, its
application grows in more and more fields including military affairs, entertainment, service,
medical treatment, etc. As the growth of robotic technology, we now have higher
requirement on performance of robots. Therefore, AI robots are now under the spot light.

In this context, this 3-wheel driven (WD) robot car based on Arduino is developed. It is agile
and can be controlled conveniently. Various precision modules can be added onside to
process data sent from sensors. It supports the following functions:

1. Obstacle avoiding – it can self-adjust its direction when running, in case of crash or
scratch.

2. Line following – it can detect the black line on a white surface with the photoelectric
diode (infrared radial parts include an emitter and a receiver), so it can run along the
line.

3. Remote control – it can be controlled remotely to go forward and backward and turn
left and right based on the command sent from a mobile on Android via Bluetooth.

Principle
Three working modes after the car is power on:

Mode No.1: Remote control via Bluetooth
You can control the car to go forward and backward and turn left and right by commands
via Bluetooth. At the same time, you can switch between the modes and control the buzzer
to beep.

Mode No.2: Obstacle avoidance by ultrasonic
Under this mode, the car can detect and bypass the obstacles in front automatically.

Mode No.3: Line following
Under this mode, on a white surface with routes of 3cm-width black lines, the car can go
along the black lines.



www.adeept.com

6

Car to turn left

Car to turn right

Enter the mode
of line following

Commands for Remote Control via Bluetooth
Command from the Remote via Bluetooth Car's Function to the Command

a Car goes forward
b Car turns right
c Car turns left
d Car goes backward
e Enter the mode of remote control via

Bluetooth; the car stops
f Car starts to avoid obstacles automatically
g Car starts to follow black lines
e Buzzer beeps

Android App
An application for Android mobile is provided for you to test the smart car:

Enter the mode
of obstacle
avoidance

Car to go
backward

Car to go
forward

Enter the mode
of remote control
via Bluetooth

Buzzer to beep

Connect the car
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Assemble the following components

Effect diagram after assembling

Assembly
Preparations – Modules + Wires
A. Connect the modules with the corresponding wires.

For convenient demonstration, hereafter only the connecting end (white part) will be shown in
the figure:

4-pin Connector x1

Adeept RGB LED Module x2Adeept RGB LED Module x1

Wiring of the rest modules:

Adeept Passive Buzzer Module
+3-pin Connector

Adeept Line Finder Module
+3-pin Connector
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Assemble the following components Effect diagram after assembling

Effect diagram after assemblingAssemble the following components

Assemble the following components

Assemble Modules to the Car
A. Mount the ultrasonic module.

B. Assemble two M2*10 Screws and nuts to the A04 plate.

C. Fasten the part completed in Step A and B to the Adeept Passive Buzzer Module with screws
and nuts.

A03 x1

M1.4*6 Self-tapping
Screw x4

HC-SR04 Ultrasonic Module x1

A04 x1

M2*10 Screw x2

M2 Nut x2

Part in A
Part in B

M2 Nut x2

Adeept Passive
Buzzer Module x1
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Effect diagram after assembling

Effect diagram after assemblingAssemble the following components

Effect diagram after assemblingAssemble the following components

D. Take out a rocker arm of the servo and mount it to A05 with the screw packaged

E. Combine the parts in Step C and D.

Rocker arm x1

A05 x1

Self-tapping screw packaged with servo x1

M3 Nut x2

M3*8 Screw x2
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Assemble the following components

Effect diagram after assembling

F. Fasten the two Adeept RGB LED Modules to A01.

M2 Nut x2

A01 x1

Adeept RGB LED
Moudle x1

M2 Nut x2
Pay attention to the hole on A01. DO NOT

assemble them inversely.M2*8 Screw x2
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Assemble the following components

Effect diagram after assembling

The other Adeept RGB LED Module.

M2 Nut x2

A01 x1

Adeept RGB LED
Module x1

M2 Nut x2

M2*8 Screw x2
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Assemble the following components

Effect diagram after assembling

G. Assemble two M3*12 Copper Standoffs to A01.

M3*12 Copper
Standoff x2

M3*5 Screw x2
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First, learn the structure. The servo can connect the rocker arm and spin to drive components
bound with the arm. There are 3 types of rocker arms and 3 screws in the package. The
smallest one is to fix the arm onto the servo.

Mount and remove the rocker arm.

Rotate the rocker arm between 0 and 180 degrees.

H. Calibrate the servos.

Now adjust the servo. This step is to make the servo shaft in the middle, so the component
connected to the servo can be driven to move in a certain scope as needed.
Adjust the rocker arm to make it rotate to an almost equal angle towards left and right.

If the angle is not nearly the same, please remove the arm and install it again. Repeat the step
until nearly the SAME degree.
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Effect diagram after assembling

I. Fasten the servo to A06.

After the adjusting, the rocker arm should be in the middle axis. Remove the arm.

Make sure all servos have been adjusted and DO NOT spin the servo shaft before the whole
assembly is done for the car. If you move it accidentally, readjust before the assembly.

Assemble the following components

M2*8 Screw x2 Note: The servo shaft should be on the
other side opposite to that of the bulge

on A06.
A06 x1

M2 Nut x2

Servo x1
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Assemble the following components

Effect diagram after assembling

J. Assemble the servo to A01.

M3*5 Screw x2
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Assemble the following components

Effect diagram after assembling

View from top:

K. Mount the ultrasonic module part to the servo.

Insert the servo
shaft into the
rocker on the
ultrasonic part,
with its two probes
oriented at the logo
side on the A01
plate, fix them with
M2*8 Screw.

M2*8 Screw x1

The symmetrical line
of the ultrasonic is
overlapped with that
of A01 facing the
logo, so it can turn
left or right in the
range of 0-90°.
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Assemble the following components

Effect diagram after assembling

Assemble the Car's Lower Part
A. Fix 4 M3*6 Copper Standoffs on A02.

The 4 holes are
asymmetric. So pay
attention to the
position of this hole
when installing
them. You can place
the Adeept Uno R3
board onside to
check whether the
holes' position
complies with those
on A02 – the board
will be installed to
the standoffs later.

M3*6 Copper
Standoff x4

A02 x1

M3*5 Screw x4
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Assemble the following components

Effect diagram after assembling

Assemble the following components

B. Install two DC Motors.

DC Motor A x1

Insert two A08 plates
through the slots of
A02 from the side with
the M3*6 Copper
Standoffs and hold
them from bottom in
case of falling out.
Place the 2 DC Motors
between the two A08
plates and also hold it
together with fingers.

A08 x2

The side with a bulge of
the DC Motor should
face outward.

The side with a black wire of
the DC Motor should face
inward, and the wire on top.

Insert 2 M3*30 Screws
through the holes on
A08 and DC Motor, and
slightly tighten with M3
Nuts (nuts inward). Do
not tighten them,
otherwise the motor
cannot rotate smoothly. M3 Nut x2

M3*30 Screw x2
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Effect diagram after assembling

Complete the assembly of the other DC Motor B:

DC Motor BParts:
DC Motor B x1
A08 x2
M3 Nut x2
M3*30 Screw x2

The black wire of both
the 2 DC Motors
should be on top.

After assembly is done, thread the black and red wires of the
DC Motor through the round hole on side, which can be
organized later after the connection.
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Assemble the following components

Effect diagram after assembling

C. Assemble 4 M3*8 Copper Standoffs to A02.

M3*5 Screw x4

M3*8 Copper
Standoff x4
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Assemble the following components

Effect diagram after assembling

D. Fasten the 18650x2 Battery Holder on A02.

M3*10 Countersunk
Head Screw x2

18650x2 Battery
Holder x1

M3 Nut x2
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Assemble the following components

Effect diagram after assembling

E. Assemble the Caster wheel to A02.

M3*5 Screw x4

Caster wheel x1
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Assemble the following components

Effect diagram after assembling

F. Assemble three A04 plates to A02.

Start from A04 when
installing them

A04 x3

M3 Nut x3

M3*8 Screw x3
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Assemble the following components

Effect diagram after assembling

G. Connect the wheels to the DC Motors.

Driving wheel
x2
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H. Mount the standoffs to the Adeept Line Finder Module.
One module:

1 2

3 4

M2.5*30 Copper Standoff x1

Adeept Line Finder
Module x1

M2.5*10+6 Copper
Standoff x1

M2.5*7 Screw x3

M2.5*30 Copper Standoff x3
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The other module: (pay attention to different positions of M2.5*10+6 Standoff on the other one)

1 2

3 4

M2.5*30 Copper
Standoff x1

Adeept Line Finder
Module x1

M2.5*10+6 Copper
Standoff x1

M2.5*7 Screw
x3

M2.5*30 Copper
Standoff x3
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Assemble the following components

Effect diagram after assembling

I. Fix the Adeept Line Finder Module A part to A02.

M2.5*7 Screw x4

Mount the Adeept
Line Finder Module in
the middle of the slot

The M2.5*10+6
Copper Standoff near

the middle line

Adeept Line Finder Module A
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Effect diagram after assembling

Adeept Line Finder Module B

Assemble the other Adeept Line Finder Module B part on the other side on A02.

M2.5*7 Screw x4

Adeept Line Finder
Module in the

middle of the slot

M2.5*10+6 Standoff
toward the middle
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J. Mount the Adeept UNO R3 to A02.

Assemble the following components

M3*5 Screw x4

Adeept UNO R3 x1

Effect diagram after assembling
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K. Insert the Adeept Motor Shield V2.0 onto the Adeept UNO R3.

Assemble the following components

Effect diagram after assembling

Adeept Notor Shield x1
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L. Plug the Bluetooth module into the Adeept Motor Shield V2.0.

Assemble the following components
Bluetooth module x1

Effect diagram after assembling

Connect the
Bluetooth module
to port P3 of the
Adeept Motor
Shield, with the
module's +5V near
the outside of the
board. DO NOT
insert the pins
inversely or
incorrectly in pins.
Check twice if
necessary.
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Final Assembly
A. Assemble upper part and lower part.

Assemble the following components

Before assembly,
connect each module
to the Adeept Motor
Shield V2.0, and
organize the wires.

Upper part

M3 Nut x3
M3*8 Screw x3

Install or uninstall the
Bluetooth module

through this hole. Note:
DO NOT insert the pins
inversely or incorrectly in
pins. Check more times.

Lower Part

Assemble the following components
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Circuit Connection

DC Motor A

DC Motor B

18650x2 Battery
Holder

Servo

Adeept RGB
LED Module

Adeept RGB
LED Module

Adeept Passive
Buzzer Module

HC-SR04
Ultrasonic Module

Adeept Line
Finder Module A

Adeept Line
Finder Module B

Connect components based on the figure
Pay attention to match the wire and port and not
connect inversely.
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Take out 2 ribbons and 2 batteries.

To remove the batteries, just pull the ribbon and take them out.

Install the batteries into the holder based on the pole.

Insert the batteries into the rings - ribbon closer to the anode.

Roll one end of the ribbon to let through a battery and fix.

Install and Remove Batteries
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Software & Hardware

What is Arduino?
Arduino is an open-source electronics platform based on easy-to-use hardware and software.

Arduino boards are able to read inputs - light on a sensor, a finger on a button, or a Twitter
message - and turn it into an output - activating a motor, turning on an LED, publishing something
online. You can tell your board what to do by sending a set of instructions to the microcontroller
on the board. To do so you use the Arduino programming language (based on Wiring), and the
Arduino Software (IDE), based on Processing.

Over the years Arduino has been the brain of thousands of projects, from everyday objects to
complex scientific instruments. A worldwide community of makers - students, hobbyists, artists,
programmers, and professionals - has gathered around this open-source platform, their
contributions have added up to an incredible amount of accessible knowledge that can be of
great help to novices and experts alike.

Arduino was born at the Ivrea Interaction Design Institute as an easy tool for fast prototyping,
aimed at students without a background in electronics and programming. As soon as it reached a
wider community, the Arduino board started changing to adapt to new needs and challenges,
differentiating its offer from simple 8-bit boards to products for IoT applications, wearable, 3D
printing, and embedded environments. All Arduino boards are completely open-source,
empowering users to build them independently and eventually adapt them to their particular
needs. The software, too, is open-source, and it is growing through the contributions of users
worldwide.

Why Arduino?
Thanks to its simple and accessible user experience, Arduino has been used in thousands of

different projects and applications. The Arduino software is easy-to-use for beginners, yet flexible
enough for advanced users. It runs on Mac, Windows, and Linux. Teachers and students use it to
build low cost scientific instruments, to prove chemistry and physics principles, or to get started
with programming and robotics. Designers and architects build interactive prototypes, musicians
and artists use it for installations and to experiment with new musical instruments. Makers, of
course, use it to build many of the projects exhibited at the Maker Faire, for example. Arduino is a
key tool to learn new things. Anyone - children, hobbyists, artists, programmers - can start
tinkering just following the step by step instructions of a kit, or sharing ideas online with other
members of the Arduino community.
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How Should I Use Arduino?
If you are a beginner with Arduino, Arduino learning kits on our website www.adeept.com would
be a prefect step into this fantastic field!

One type of Arduino board are used in this car kit: Adeept UNO R3 board

Power

The Arduino/Genuino Uno board can be powered via the USB connection or with an external
power supply. The power source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The
adapter can be connected by plugging a 2.1mm center-positive plug into the board's power jack.
Leads from a battery can be inserted in the GND and Vin pin headers of the POWER connector.

The board can operate on an external supply from 6 to 20 volts. If supplied with less than 7V,
however, the 5V pin may supply less than five volts and the board may become unstable. If using
more than 12V, the voltage regulator may overheat and damage the board. The recommended
range is 7 to 12 volts.

The power pins are as follows:

Vin. The input voltage to the Arduino/Genuino board when it's using an external power source
(as opposed to 5 volts from the USB connection or other regulated power source). You can supply
voltage through this pin, or, if supplying voltage via the power jack, access it through this pin.

5V. This pin outputs a regulated 5V from the regulator on the board. The board can be supplied
with power either from the DC power jack (7 - 12V), the USB connector (5V), or the VIN pin of the
board (7-12V). Supplying voltage via the 5V or 3.3V pins bypasses the regulator, and can damage
your board. We don't advise it.

3V3. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA.

GND. Ground pins.

IOREF. This pin on the Arduino/Genuino board provides the voltage reference with which the
microcontroller operates. A properly configured shield can read the IOREF pin voltage and select
the appropriate power source or enable voltage translators on the outputs to work with 5V/3.3V.

http://www.adeept.com
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Input and Output

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(),
digitalWrite(), and digitalRead() functions. They operate at 5 volts. Each pin can provide or
receive 20 mA as recommended operating condition and has an internal pull-up resistor
(disconnected by default) of 20-50k ohm. A maximum of 40mA is the value that must not be
exceeded on any I/O pin to avoid permanent damage to the microcontroller.

In addition, some pins have specialized functions:

Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. These pins are
connected to the corresponding pins of the ATmega8U2 USB-to-TTL Serial chip.

External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a low value,
a rising or falling edge, or a change in value. See the attachInterrupt() function for details.

PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite() function.

SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication using the SPI
library.

LED: 13. There is a built-in LED driven by digital pin 13. When the pin is HIGH value, the LED is on,
when the pin is LOW, it's off.

TWI: A4 or SDA pin and A5 or SCL pin. Support TWI communication using the Wire library.

The Uno has 6 analog inputs, labeled A0 through A5, each of which provide 10 bits of resolution
(i.e. 1024 different values). By default they measure from ground to 5 volts, though is it possible
to change the upper end of their range using the AREF pin and the analogReference() function.

There are a couple of other pins on the board:

AREF. Reference voltage for the analog inputs. Used with analogReference().

Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button to
shields which block the one on the board.

Arduino Software (IDE)
Arduino Software (IDE) is used to write and upload the code for Arduino Board. First, install
Arduino software (IDE): visit https://www.arduino.cc/en/Main/Software. Download the
corresponding installation program according to your operating system. If you are a Windows
user, please select the “Windows Installer” to download and install the driver correctly.

https://www.arduino.cc/en/Main/Software
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After the download completes, run the installer. For Windows users, there may pop up an
installation dialog box of the driver during the installation. Please agree the installation when it
appears.

After installation is completed, an Arduino software shortcut will be generated on the desktop.
Run the IDE.

The interface of Arduino software is as follows:
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The Arduino Integrated Development Environment - or Arduino Software (IDE) - contains a text
editor for writing code, a message area, a text console, a toolbar with buttons for common
functions and a series of menus. It connects to the Arduino and Genuino hardware to upload
programs and communicate with them.

Verify: Checks your code for errors when compiling it.

Upload: Compiles your code and uploads it to the configured board.

Before uploading your sketch, you need to select the correct items from the Tools > Board and
Tools > Portmenus. The boards are described below. On the Mac OS X, the serial port is probably
something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) or
/dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or /dev/tty.USA19QW1b1P1.1
(for a serial board connected with a Keyspan USB-to-Serial adapter). On Windows, it's probably
COM1 or COM2 (for a serial board) or COM4, COM5, COM7, or higher (for a USB board) - to find
out, you look for USB serial device in the ports section of the Windows Device Manager. On
Linux, it should be /dev/ttyACMx, /dev/ttyUSBx or similar.

Once you've selected the correct serial port and board, press the upload button in the toolbar or
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select the Upload item from the Sketch menu. Current Arduino boards will reset automatically
and begin the upload. With older boards (pre-Diecimila) that lack auto-reset, you'll need to press
the reset button on the board just before starting the upload. On most boards, you'll see the RX
and TX LEDs blink as the sketch is uploaded. The Arduino Software (IDE) will display a message
when the upload is completed, or show an error.

When you upload a sketch, you're using the Arduino bootloader, a small program that has been
loaded on to the microcontroller on your board. It allows you to upload code without using any
additional hardware. The bootloader is active for a few seconds when the board resets; then it
starts whichever sketch was most recently uploaded to the microcontroller. The bootloader will
blink the on-board (pin 13) LED when it starts (i.e. when the board resets).

Note: If you are using an external programmer with your board, you can hold down the "shift"
key on your computer when using this icon. The text will change to "Upload using Programmer".

New: Creates a new sketch.

Open: Presents a menu of all the sketches in your sketchbook. Clicking one will open it
within the current window overwriting its content.

Note: Due to a bug in Java, this menu doesn't scroll; if you need to open a sketch late in the list,
use the File | Sketchbook menu instead.

Save: Saves your sketch.
Serial Monitor: Opens the serial monitor.

Additional commands are found within the five menus: File, Edit, Sketch, Tools, and Help. The
menus are context sensitive, which means only those items relevant to the work currently being
carried out are available.

Since version 1.0, files are saved with an .ino file extension. Previous versions use the .pde
extension. You may still open .pde named files in version 1.0 and later, and the software will
automatically rename the extension to .ino.

Upload Program
After the preparations above, next we will upload the program (example sketches provided) to
the Adeept UNO R3 board.

Note: Before downloading the program, please remove the Bluetooth module first, otherwise the
download program will fail.

Open the program provided for the control board, the file “Adeept3WDBluetoothCar.ino”.
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Connect the Arduino UNO R3 board to the PC. Select Tool -> Board “Arduino/Genuino Uno”, and
Port - > COM10. Also here is COM10, assigned to the Uno, but it can be COM1, COM2, COM3...
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Click the button to upload the sketch to the board.
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Afterword
Thanks for purchasing our product and reading the manual! If you spot any errors or have
any ideas or questions for the product and this guide, welcome to contact us! We will
correct them if any as quickly as possible.

After completing all projects in the guide, you should have some knowledge of the book and
Arduino, thus you can try to change the car into other projects by adding more Adeept
modules or changing the code for extended functions.

For more information about Arduino, Raspberry Pi, smart car robot, or robotics, etc., please
follow our website www.adeept.com. We will introduce more cost-effective, innovative and
intriguing products!

Thanks again for choose Adeept product!

http://www.adeept.com
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